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Overview 
Use this guide for your staff to learn core tasks for the IDEXX Cornerstone* Practice Management System. Coordinate the 
completion of your training before your scheduled database installation date.   

 

Learning Dates: _______________      Database Installation Date: _______________ 
 

• Post a copy of this schedule in a location where everyone can review it.   

• Using the indicated manuals and the schedule, complete the sections and chapters identified prior to your 
database installation date.  

Resources 
The following resources are available for additional help with your Cornerstone software. 

Resource Recommended Use Location 

Cornerstone 8.3 Administrator’s Manual 
Find reference information and 
procedural steps for setup and 
system configuration in Cornerstone. 

• Icon installed on your desktop 
• Start > Programs > 

Cornerstone > Manuals 
• idexx.com/cornerstoneresources 

Cornerstone 8.3 User’s Manual 
Find reference information and 
procedural steps for using 
Cornerstone to perform daily tasks. 

• Icon installed on your desktop 
• Start > Programs > 

Cornerstone > Manuals 

• idexx.com/cornerstoneresources 

Cornerstone 8.3 Default and Security Settings Guide 
(DSSG) 

View default settings and the order in 
which they must be addressed once 
the database is loaded. 

Also includes recommended security 
settings by practice role. 

idexx.com/cornerstoneresources 

IDEXX Learning Center  

Access online courses, webinars, 
tutorials, podcasts, and “how to” 
video snippets for tasks in 
Cornerstone. 

idexxlearningcenter.com 

Cornerstone Practice Management Resource Library Access tools, tips, and training to 
maximize your performance. idexx.com/cornerstoneresources 

IDEXX Cornerstone Coaching 

Offers targeted, flexible solutions for 
educating new and existing staff or 
for meeting specific practice goals 
that require advanced instruction. 

idexx.com/cornerstonecoach 

Cornerstone Help System 

View window-specific information and 
procedural steps for setting up your 
Cornerstone system and performing 
daily tasks. 

• Press F1 on any Cornerstone 
window or dialog box  

• On the Cornerstone menu bar, 
select Help > Contents 

Training Files and Print-based Courses 

Work with the Cornerstone training 
files data to learn everyday tasks in 
your practice without jeopardizing the 
integrity of your real medical records 

• Start > Programs > 
Cornerstone > Training Files  

• Start > Programs > 
Cornerstone > Training Files–
Print Based Courses 
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Management Checklist for Day of Go Live  
Use this guide when you receive the converted database CD. Make sure to complete all critical tasks before going live 
with the system to ensure a successful implementation. The entire process may take 4-8 hours to complete. 

 

Setup  Topic Estimated 
Time 

Critical 
to Live 

Completed 
() 

Load CD 
Containing your 

Cornerstone 
Database 

(converted from 
your former 
database) 

Install Your New Database 
1. Ensure all users are logged out of the Cornerstone system. 
2. Insert the data conversion CD into your server’s CD-ROM drive. 

The CD should automatically run the installation program. 
3. In the black command window, when prompted, type import and then 

press the Enter key. 
The installation program will: 
1. Stop the Cornerstone database engine. 
2. Back up your existing Cornerstone database, if any. 
3. Copy the new database to the system. 
4. Restart the Cornerstone database engine. 
Once you start using this database, do not reload the database from the CD 
unless instructed to do so by IDEXX Cornerstone Support personnel. 
For further assistance loading your database, call  
Cornerstone Support at 1-800-695-2877. 

10-40 
minutes X 

 

Update Database 
 

Update Your Database 
1. Start Cornerstone. Click Yes when you see this message: The 

executable version and the database version do not match. Do you want 
the database brought up to date? 

2. The Cornerstone Update dialog box appears. Click OK. 
3. During the database update, the update program checks to see which 

backup software is installed on your server or single user system. If the 
update program locates one of three supported backup software 
packages, click OK on the Backup Verification Setup window to set up 
Cornerstone to automatically verify the backup and to continue. 

4. The Cornerstone Database Update Dialog Box may appear. Click Yes 
on all windows. 

5. After the update is complete, click OK. 

10-40 
minutes X 

 

Log into 
Cornerstone 

Log In  
When Cornerstone opens, use this username and password to log in: 
Username = Cornerstone 
Password = CS 

1-2 minutes X 
 

Verify A/R Verify Accounts Receivable Data 
To verify that accounts receivable data converted correctly: 
1. On the menu, select Reports > End of Period > End of Month. 
2. In the Monthly periods area, select Current.  
3. In the Report list, select Accounts Receivable Report – By Client 

Name, and then click Preview. 
4. On the Accounts Receivable Filter window, click OK. 
5. Scroll to bottom of report to verify A/R. 

5 minutes X 

 

Setup 
Manual Topic Pages Estimated 

Time 
Critical 
to Live 

Completed 
() 
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Setup Tasks 
Consult the Administrator’s Manual for detailed instructions 
on setting up the Cornerstone features you plan to use. 

    

Cornerstone 
Administrator’s 

Manual 

Ch 1.   Getting Started with Cornerstone Setup 

Ch 2.   Setting Up Cornerstone Controls 

Ch 3.   Setting Up Lists and Information 

Ch 4.   Setting Practice and Workstation Defaults 

Ch 5.   Setting Staff Defaults 

Ch 7.   Getting Started with Cornerstone Inventory Setup 

Ch 8.   Setting Up a Single Location Inventory System 

Ch 10. Setting Up Your Invoice Items 

Ch 11. Other Inventory Setup Tasks 

Ch 12. Setting Up the Appointment Scheduler 

Ch 13. Setting Up the Electronic Whiteboard 

Ch 14. Setting Up a Reminder System 

Ch 16. Setting Up Vital Signs/Weight 

Ch 17. Setting Up Medical Notes and Correspondence 

Ch 20. End of Day Processing 

Ch 21. End of Month Processing 

Ch 22. End of Year Processing 

Ch 28. Using the Backup Verification Assistant  

Ch 30. Using the Time Clock 

 
 

See breakdown 
below 

6-10 hours 
 

See breakdown 
below 

X 

 

Setup 
Manual Topic Pages Estimated 

Time 
Critical 
to Live 

Completed 
() 

Default and 
Security Settings 
Guide (DSSG) 

Default and Security Settings 
The default setting phase outlines the defaults that must be 
addressed and the order in which they must be addressed 
once the clinic’s database is loaded. This phase also 
includes the Cornerstone security settings. 

 
 

See breakdown 
below 

3-7 hours 
 

See breakdown 
below 

X  

Default settings are presented in a table. An overview 
provides instructions. 
Sequence of default settings: 

• Defaults critical for the live practice data entry 
(rekeying) phase of a new installation 

• Defaults critical for Appointment Scheduler setup, if 
appointments will be rekeyed 

• Defaults critical for go live phase of a new installation 

• Miscellaneous defaults that are important for advanced 
use and owner/manager responsibilities  

• Defaults important for Electronic Whiteboard setup. 

• Imaging default settings. 

• Laboratory default settings. 

p. 3-103 3-5 hours X  

Security settings overview p. 104 10 minutes X  

Security setting recommendations based on job title. p. 105-136 1 hour X  
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http://www.idexx.com/pubwebresources/pdf/en_us/smallanimal/practice-management/cornerstone/cornerstone-administrators-manual-83.pdf
http://www.idexx.com/pubwebresources/pdf/en_us/smallanimal/practice-management/cornerstone/cornerstone-administrators-manual-83.pdf
http://www.idexx.com/pubwebresources/pdf/en_us/smallanimal/practice-management/cornerstone/cornerstone-administrators-manual-83.pdf
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http://www.idexx.com/pubwebresources/pdf/en_us/smallanimal/practice-management/cornerstone/cornerstone-default-security-settings-83.pdf
http://www.idexx.com/pubwebresources/pdf/en_us/smallanimal/practice-management/cornerstone/cornerstone-default-security-settings-83.pdf


 

Setup Manual Topic Page(s) 
Estimated 

Time 
Critical 
to Live 

Completed 
() 

Cornerstone 
Administrator’s 

Manual 
continued 

 

Getting Started with Cornerstone Setup 
See also 
Cornerstone Basics—Setup snippet videos 

p. 5-8 10 minutes X  

Setting Up Cornerstone Controls p. 9-30 20 minutes X  

Setting Up Lists and Information p. 31-73 20 minutes X  

Setting Practice and Workstation Defaults 
See also 
Set Practice Defaults snippet video 
Set Workstation Defaults snippet video 
Boarding and Grooming snippet videos 

p. 74-140 20 minutes X  

Setting Staff Defaults 

See also 

Staff snippet videos 

p. 141-145 20 minutes X  

Getting Started with Cornerstone Inventory Setup 

See also 

Inventory snippet videos 

p. 156-161 20 minutes X  

Setting Up a Single Location Inventory System 

See also 

Inventory snippet videos 

p. 162-164 2 hours X  

Setting Up Your Invoice Items 

See also  

This document, Appendix B—Invoice Item Setup List (p. 23-
30) 

Invoice Item snippet videos 

p. 171-241 1 hour X  

Other Inventory Setup Tasks 

See also 

Inventory snippet videos 

p. 242-252 20 minutes X  

Setting Up the Appointment Scheduler  

See also 

Appointment Scheduler snippet videos 

p. 253-263 40 minutes X  

Setting Up the Electronic Whiteboard 

See also 

Whiteboard snippet videos 

p. 264-267 15 minutes X  

Setting Up a Reminder System 

See also 

 This document, Appendix B—Reminder Series Diagram  
(p. 34) 

p. 268-289 45 minutes X  

Setting up Vital Signs/Weight p. 294-304 30 minutes X  
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http://www.idexx.com/pubwebresources/pdf/en_us/smallanimal/practice-management/cornerstone/cornerstone-administrators-manual-83.pdf
http://www.idexx.com/pubwebresources/pdf/en_us/smallanimal/practice-management/cornerstone/cornerstone-administrators-manual-83.pdf
http://www.idexx.com/pubwebresources/pdf/en_us/smallanimal/practice-management/cornerstone/cornerstone-administrators-manual-83.pdf
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1615
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1616
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1646
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1112
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1994
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1117
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1117
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1995
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1117
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1111
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1205


 

Setup Manual Topic Page(s) 
Estimated 

Time 
Critical 
to Live 

Completed 
() 

Cornerstone 
Administrator’s 

Manual 
continued 

Setting Up Medical Notes and Correspondence 

See also  

This document, Appendix B—Medical Notes and 
Correspondence Bookmark List (p. 31-33) 

Medical Notes and Correspondence snippet videos 

p. 305-343 1 hour X  

End of Day Processing p. 355-372 20 minutes X  

End of Month Processing p. 373-396 20 minutes X  

End of Year Processing 

See also 

This document, Appendix B—End of Year Checklist (p. 35) 

p. 397-406 20 minutes X  

Using the Backup Verification Assistant 

See also 

IDEXX Backup Instructions 

IDEXX Cornerstone Backup Verification Assistant 

Both located at idexx.com/cornerstoneresources  

p. 439-440 30 minutes X  

Using the Time Clock p. 449-454 15 minutes X  

      

N/A 

Printer Assignments 
Set printers that will be used to print end of day reports for 
balancing during the live data entry (rekeying) phase of the 
installation. 
Important: Printer assignments must be set for each printer. 
You must physically go to each workstation to change 
printer assignments. 
To set printer assignments on each workstation: 
1. From the menu bar, select File > Printer Assignment. 

2. Select one of the options from the submenu (End of 
Day, End of Month, End of Year, General Reports, or 
Correspondence).  

3. From the Printer list, select a printer. 

4. Select any reports in the list that should be printed to 
this printer from this station.  
Use the Ctrl key to single select multiple reports or click 
the Select All or Deselect All button. 

5. Click OK to save. (Save the report information for this 
printer before selecting a different printer.) 

6. Repeat this process for all reports included in End of 
Day, End of Month, End of Year, General Reports 
and Correspondence. 

See also 
Set Printer Assignments snippet video 

N/A 5 minutes per 
computer X 
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http://www.idexx.com/view/xhtml/en_us/smallanimal/education/reference-library/cornerstone-resources.jsf?SSOTOKEN=0
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=1655


 

Setup Manual Topic Page(s) 
Estimated 

Time 
Critical 
to Live 

Completed 
() 

This document, 
Appendix A 

Live Data Entry—Rekeying Your Data 
See the Rekeying Your Data section (Appendix A) for 
procedural steps to rekey data into your Cornerstone 
database. Typically, rekeying is done so that you add the 
data that was accumulated from the time you sent your 
database to Cornerstone to be converted until you are ready 
to “go live” with your new system. 
Do not enter information out of order or use your 
Cornerstone System for day-to-day operations until you 
have rekeyed all of your information. Data to enter may 
include invoices, payments, appointments, new clients, new 
patients, client/patient information, weights, reservations, lab 
results, medical notes, and image results. 

p. 11-18 See related 
items above X 

 

This document, 
Appendix B 

Review Go Live Task Checklist 
During the go live phase of installation, your practice will be 
live on your new Cornerstone system. 
Review the checklist list immediately after you finish 
rekeying and are approaching Go Live time.  

p. 20-22 See related 
items above X 

 

      

8.3 Quick 
Reference Guides 

Quick Reference Guides 

Two page quick reference guides provide basic information 
about many Cornerstone features. Click the links to view 
and download the guides. 

Appointment Scheduler 

Basics 

Boarding and Grooming 

Check-in and Census List 

Client Account—Payments 

Daily Planner 

Electronic Whiteboard 

End of Day Activities 

Estimates 

Invoices 

Medical Notes 

Patient Clipboard 

Patient Visit List 

Prescriptions 

Rabies Tags and Certificates 

Referral Communication and Management 

Reports 

Time Clock 

N/A 10 minutes 
each 
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https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=2509
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=2511
https://www.idexxlearningcenter.com/idexx/user_activity_info.aspx?id=2507


 

Self-Paced Training—All Staff 
The purpose of this training is to provide a way for new users to learn Cornerstone basics in the three weeks before 
Cornerstone Go Live. Throughout this training, you will be working in the Cornerstone training files, which contain realistic, 
but fictitious, client and patient information. The IDEXX Cornerstone 8.3 training files allow you to learn the materials 
without compromising your practice’s actual data. 

To maximize your training experience, it is recommended that you work through all of the activities and complete all 
practice exercises. 

 

Learning  
Weeks and 

Dates 
Topic 

 

User’s Manual (view the Cornerstone 8.3 User’s Manual) 

 

Staff Roles 

 
Completed 

() 

3 Weeks Before 
Go Live 

 
Date:_________ 

Getting Started 

Clients and Patients 

Getting Started with Cornerstone Software  (p. 5-17)  

Using the Patient Clipboard (p. 18-30)  

Entering Client Information (p. 31-44) 

Entering Patient Information (p. 45-71) 

Management  

Reception 

Medical 
Team 

 

3 Weeks Before 
Go Live 

 
Date:_________ 

Patient Check-In 

Appointments 

Census List 

Patient Visit List (PVL) 
Travel Sheets  

Using the Appointment Scheduler (p.91-110) 

Patient Check-in and Check-out (p. 111-117) 

Using the Census List (p. 118-119)  

Using the Patient Visit List (p.120-127)  

Travel Sheets (p.125, 177-178) 

Management  

Reception 

Medical 
Team 

 

2 Weeks Before 
Go Live 

 
Date:_________ 

Vital Signs  

Estimates 

Medical Notes  

Recording Vital Signs and Weight Information (p. 220-227)  

Creating Estimates (p.156-169)  

Using Medical Notes and Correspondence (p. 228-272) 

Management  

Reception 

Medical 
Team 

 

2 Weeks Before 
Go Live 

 

Date:_________ 

Admit and Pre-
Procedures  

Prescriptions  

Invoicing  

Rabies Certificate 

Using the Electronic Whiteboard (p. 128-155) 

Working with Prescriptions (p. 283-292) 

Invoicing (p. 170-190)  

Issuing a Rabies/Vaccine Tag and Rabies Certificate (p. 184-188) 

Management  

Reception 

Medical 
Team 

 

2 Weeks Before 
Go Live 

 

Date:_________ 
 

Daily Planner 

Call Backs  

Accounts & Payments 

End of Day Activities 

Using the Daily Planner (p. 207-209)  

Entering Call Backs (p. 53-58, 208)   

Maintaining Client Accounts and Payments (p. 191-206)  

Management  

Reception 

Medical 
Team 

 

Management Tasks after Go Live 
Review these tasks within a day or two of going live. Create your own priority list of items to be completed with estimated 
completion dates. 

Customization Task Checklist 
See this document, Appendix B (p. 19-38) 

These tasks should be reviewed within a day or two of going live.  

Your Next Steps 
Congratulations on your successful Go Live with Cornerstone! Use the IDEXX Learning Center to access resources for 
your specific goals and needs beyond your Go Live. Visit idexxlearnincenter.com >Topics> Cornerstone 8.3 Training. 
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Live Data Entry  

Important Notes
•	 Follow	these	procedures	only	after	you	have	complected	the	Defaults	and	Security	section	above.	
•	 This	guide	provides	steps	to	rekey	information	into	the	Cornerstone*	Practice	Management	System.
•	 Do	not	enter	information	out	of	order	or	use	your	Cornerstone	system	for	day-to-day	operations	until	you	have	
rekeyed	all	of	your	information.

•	 Make	sure	you	complete	a	manual	backup	before	rekeying	information.
•	 If	you	need	help,	call	Cornerstone	Support	at	1-800-695-2877.	

Overview
The	following	steps	provide	an	overview	of	the	rekeying	process.	For	overview	steps	2	and	3,	follow	the	detailed	
instructions	in	the	Rekeying	Your	Data	section	starting	on	page	13.
1. Complete Critical Pre-Rekeying Tasks

Prior to rekeying information, receive guidance from the appropriate training materials or assistance from Cornerstone 
Support (1-800-695-2877) for the following critical tasks:

•	 Special	actions	set	up	for	applicable	invoice	items	
Optional:	Preview/print	the	Invoice	Item	Information	Report

•	 Discounts	applied	to	appropriate	invoice	items	
Optional:	Preview/print	the	Invoice	Item	Information	Report

•	 Verify	all	clients	marked	to	receive	preset	discounts	are	selected	in	Cornerstone.
Optional:	Preview/print	the	Client	Discounts	Report

•	 Reminder	protocol	set	up	for	generating	and	satisfying	reminders
Optional:	Preview/print	the	Invoice	Item	Reminder	Information	Report

•	 Taxes	applied	to	invoice	items	
Optional:	Preview/print	the	Invoice	Item	Tax	Setup	Report

•	 Groups,	smart	groups,	and	pick	lists	set	up	and	charges	applied
•	 Staff	and	Cashier	IDs	and	passwords	set	up	

2. Change system date
•	 Change	the	system	date	to	match	the	date		
of	the	transactions	being	rekeyed.	

•	 You'll	need	to	repeat	this	step	for	each	day	for	which	you	
have	data	to	rekey.	
For	details,	see	"Rekeying	Your	Data:	Detailed	Steps"	
begining	on	page	13.

3. Enter transactions 
•	 For	the	system	date	set	in	#2,	enter	the	records	and	
transactions	that	need	to	be	rekeyed,	such	as	invoices,	
payments,	new	clients,	new	patients,	client	or	patient	
information	changes,	rabies	tag	additions	or	changes,	
weights,	and	medical	history	according	to	your	practice’s	
needs.	 	 	

•	 Transactions	applying	to	paper	chart	and	chartless	
practices
•	 Enter	invoices	and	payments
•	 Enter	payments	only
•	 Correct	an	invoice



•	 Correct	payment	amounts
•	 Correct	payment	types
•	 Add	new	clients	and	patients
•	 Change	patient	information
•	 Add	or	change	rabies	tag	information
•	 Add	weights
•	 Change	client	records
•	 Add	scheduled	appointments

For	details,	see	"Rekeying	Your	Data:	Detailed	Steps"	begining	on	page	13.

•	 Lab	and	Imaging	Results
Complete training prior to entering results. 
•	 Reference	Laboratory	Results

 ○ IDEXX Reference Laboratories—Verify	information	that	was	automatically	imported	into	
Cornerstone.	You	can	also	scan	the	lab	results	report,	import,	or	manually	enter	lab	results.	
VetConnect*	PLUS	(vetconnectplus.com)	users	can	access	lab	results	within	Cornerstone.	

 ○ Antech Diagnostics®—See	“Chapter	31:	Using	the	Antech	Diagnostics®	Module”	in	the	Cornerstone 
User’s Manual.	

 ○ Other—Scan	lab	results	report,	import,	or	manually	enter	lab	results.
•	 In-clinic	Laboratory	Results

 ○ IDEXX—Verify	information	that	was	automatically	imported	into	Cornerstone.	You	can	also	scan	the	
lab	results	report,	import,	or	manually	enter	lab	results.	VetConnect*	PLUS	(vetconnectplus.com)	
users	can	access	lab	results	within	Cornerstone.			
For	more	information,	see	the	IDEXX Cornerstone* Guide: In-House Laboratory with IDEXX 
SmartLink* Technology for 8.3	(Start > All Programs > Cornerstone > Training Files-Print-based 
Courses > 8.3 In-House Labs Training).	

 ○ Non-IDEXX—Scan	lab	results	report,	import,	or	manually	enter	lab	results.
•	 Imaging	Results	

See the IDEXX Cornerstone* 8.3 Diagnostic Imaging User's Guide (Start > All Programs > Cornerstone > 
Training Files-Print-based Courses > 8.3 Diagnostic Imaging Guide).

 ○ IDEXX Imaging Results—Import	results	into	Cornerstone.	
 ○ Non-IDEXX Imaging Results—Send	via	DICOM®	to	Cornerstone	or	import	results	into	Cornerstone.

•	 Additional	Transactions	Mostly	Applying	to	Chartless	Practices
•	 Enter	problems,	diagnosis,	medical	notes,	and	patient	info,	charges,	etc.	for	patients	currently	in	the	
hospital

4. Preview reports to balance

Preview the Daily Deposit Report to make sure payment totals entered in Cornerstone match those from the total payment 
transaction report being rekeyed.	

a.	 From	the	menu	bar,	select	Reports > End of Period > End of Day.	
b.	 In	the	Daily periods	area,	select	Current.	
c.	 In	the	Report list	area,	select	the	Daily	Deposit	Report.	
d.	 Click	Preview.	
e.	 To	print	for	all	cashier	IDs,	click	OK.	Or,	to	sort	by	individual	cashier	ID,	enter	an	ID	and	click	OK.																																						
f.	 At	the	Reports	Preview	window,	verify	that	this	report	contains	the	information	you	are	looking	for.	To	print	

the	report,	click	Print.	
g.	 Choose	the	print	options	and	click	OK.
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h.	 If	totals	do	not	match,	print	the	Daily	Payment	Register—By	Payment	Type	Report	to	locate	the	errors.	
After	correcting	the	errors,	preview	the	Daily	Deposit	Report.

5. Complete a manual backup  
See	page	7	in	the	main	section	of	this	document	for	more	information.

Repeat steps 2-5 to rekey information for another day until all days/transactions have been rekeyed.
When you're done rekeying information, change the system date back to today's date.

Rekeying Your Data: Detailed Steps
Use the steps listed below to rekey data into your Cornerstone database. Typically, rekeying is done so that you add 
the data that was accumulated from the time you sent your database to Cornerstone to be converted until you are 
ready to “go live" with your new system.

Change system date 
Change	the	date	on	your	server	computer	first.	Then	change	the	date	on	all	workstation(s)	that	you're	using	to	
do	the	rekeying	work.	The	instructions	are	slightly	different	depending	on	whether	you're	using	Windows®	XP	or	
Windows	7.

Note: If	you	don't	reset	the	dates	on	all	the	computers	that	you	use	to	rekey	data,	you	could	experience	errors	that	
will	prevent	you	from	using	Cornerstone.	Be	aware	of	the	following:
•	 While	rekeying	is	in	process,	do	not	perform	any	Cornerstone	activities	on	any	workstations	where	the	system	

date	has	not	been	reset.	
•	 All	activities	you	perform	on	reset	workstations	will	reflect	the	date	to	which	that	computer	has	been	reset.

To reset the date on computers with Windows XP:
1.	 Do	the	following	on	your	Cornerstone	server:

a.	 Double-click	the	date	in	the	lower	right	corner	of	your	screen.	
b.	 Click	Change date and time settings.
c.	 On	the	Date	and	Time	Properties	window,	select	a	new	date	and	click	OK.

2.	 Repeat	these	steps	on	each	workstation	that	you	are	using	to	rekey	data.

To reset the date on computers with Windows 7:
1.	 Do	the	following	on	your	Cornerstone	server:

a.	 Click	the	date	in	the	lower	right	corner	of	your	screen.	
b.	 Click	Change date and time settings.
c.	 On	the	Date	and	Time	window,	click	Change date and time.
d.	 Select	a	new	date	and	click	OK.

2.	 Repeat	these	steps	on	each	workstation	that	you	are	using	to	rekey	data.

Enter invoices and payments 

1.	 With	the	client’s	account	displayed	on	the	Patient	Clipboard	window,	right-click	the	patient’s	name	in	the	Patient 
list	area	and	select	Invoice.

2.	 In	the	Invoice	number	box,	press	TAB.
3.	 From	the	Invoice	type	list,	select	the	type	of	invoice	and	press	TAB.
4.	 In	the	first	Item ID	field,	enter	the	item	ID.	Press	F2	or	double-click	to	search	for	item	IDs.	Then,	press	TAB.
5.	 If	necessary,	enter	the	quantity,	amount,	staff	ID,	revenue	center,	and	date	(if	different	than	system	date).
6.	 Verify	the	information	in	the	Disc	and	Tax	columns.	If	necessary,	click	the	Disc	or	Tax	button	to	apply	a	

discount	or	tax	to	this	item.		
Note:	You	may	need	to	make	a	manual	adjustment	if	your	previous	software	calculated	taxes	differently.
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7.	 Enter	any	additional	invoice	items	until	all	items	are	added.		
IMPORTANT! Make sure both invoices match exactly before continuing.

8.	 Click	Post.
9.	 Accept	or	modify	the	information	on	the	Post	Invoice	window,	and	then	click	OK.	
10.	On	the	Payment	window,	if	your	practice	uses	cashier	passwords,	enter	the	password	in	the	Cashier password	

box.	Then,	press	TAB.
11.	 In	the	Amount	column,	enter	the	payment	amount	and	press	TAB.
12.	 In	the	Payment Type	column,	select	the	type	of	payment	from	the	drop-down	list.	If	required,	answer	the	

payment	type	prompt.
13.	Tab	to	the	Change given	box	to	verify	the	balance	after	payments.
14.	Click	Post.

Enter payments only
1.	 With	the	client’s	account	displayed	on	the	Patient	Clipboard	window,	click	the Account Information	tab	in	the	

Client information	area.
2.	 Right-click	in	the	transaction	list	area	and	select	Payment.
3.	 On	the	Payment	window,	if	your	practice	uses	cashier	passwords,	enter	the	password	in	the	Cashier password	

box.	Then,	press	TAB.
4.	 In	the	Amount	column,	enter	the	payment	amount	and	press	TAB.
5.	 In	the	Payment Type	column,	select	the	type	of	payment	from	the	drop-down	list.	If	required,	answer	the	

payment	type	prompt.
6.	 Tab	to	the	Change given	box	to	verify	the	balance	after	payments.
7.	 Click	Post.

Correct invoices and payments
The easiest way to correct invoice and payment information is to void incorrect invoices and payments and 
then input them using the instructions on the previous page. The steps required to void a payment vary slightly 
depending on whether or not the payment is attached to an invoice. 

To void an invoice
1.	 With	the	client's	account	displayed	on	the	Patient	Clipboard,	click	the	Account Information	tab	in	the	Client 

information	area.
2.	 Right-click	in	the	transaction	list	and	select	Invoice.
3.	 Double-click	in	the	Invoice number	box	and	select	the	invoice.	The	Client	Invoice	window	opens.
4.	 Click	the	Void	button.	The	Void	Invoice	window	opens.
5.	 Select	the	Check to confirm the void	check	box	to	confirm	that	you	actually	want	to	void	this	invoice.
6.	 Adjust	the	print	options,	if	necessary.
7.	 Add	comments,	if	necessary.
8.	 Click	OK	when	finished.
9.	 If	your	practice	uses	cashier	IDs,	enter	your	cashier	password.	

The	item	will	display	in	the	client'	s	account	history	as	a	voided	item.	If	a	payment	existed	on	the	original	
invoice,	you	will	have	to	issue	a	credit	or	give	cash	back	to	the	client.	(Payments	made	on	voided	invoices	are	
also	voided.)

To void a payment attached to an invoice
1.	 With	the	client's	account	displayed	on	the	Patient	Clipboard,	click	the	Account Information	tab	in	the	Client 

information	area.
2.	 Right-click	the	invoice	for	the	payment	in	the	transaction	list	select	View.
3.	 Click	the	View	button.	The	Client	Invoice	window	opens.
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4.	 Click	the	Payment	button.	The	Payment	window	opens.
5.	 If	your	practice	uses	cashier	IDs,	enter	your	cashier	password.
6.	 Click	anywhere	within	the	payment	row	to	be	voided.
7.	 Press	CTRL+D.	A	message	appears	to	confirm	the	void/delete	action.
8.	 Click	OK	to	close	the	message	and	then	click	Save	to	void	the	selected	payment.
9.	 Close	the	Client	Invoice	window.

To void a payment NOT attached to an invoice
1.	 With	the	client's	account	displayed	on	the	Patient	Clipboard,	click	the	Account Information	tab	in	the	Client 

information	area.
2.	 Right-click	the	payment	to	void	in	the	transaction	area.	The	Payment	window	opens.
3.	 If	your	practice	uses	cashier	IDs,	enter	your	cashier	password.
4.	 Click	anywhere	within	the	payment	row	to	be	voided.	The	Void	button	displays	when	a	previously	posted	

payment	is	selected.
5.	 Click	the	Void	button	or	press	CTRL+D.	A	message	appears	to	confirm	the	void/delete	action.
6.	 Click	OK	to	close	the	message	and	then	click	Post	to	void	the	selected	payment.
7.	 If	asked	if	you	want	to	print,	click	Yes	to	print	the	payment	void	or	click	No	to	close	without	printing.
8.	 Close	the	Client	Account	window.

Add new clients 
This procedure begins from the Patient Clipboard.

1.	 With	the	cursor	in	the	Client ID	box,	press	F2	or	double-click	to	open	the	Client	List	window.
2.	 Enter	the	new	client’s	last	name	to	confirm	that	there	is	not	an	existing	account.
3.	 Click	New	to	set	up	a	new	account.
4.	 In	the	Client	ID	box,	enter	a	client	ID	or	let	Cornerstone	automatically	select	an	ID	and	press	TAB.	If you are 

adding an existing client from your previous software, make sure the ID matches. 
5.	 Select	an	appropriate	title	(optional)	and	enter	the	client’s	name	and	address.
6.	 In	the	Phones	area,	double-click	to	add	a	new	phone	number.	Select	primary	and/or	a	location.
7.	 Complete	the	rest	of	the	fields	in	the Information	tab.
8.	 Enter	the	appropriate	information	on	the	Prompts/Notes	tab.
9.	 If	another	client	referred	this	new	client	to	the	practice,	enter	the	referring	client’s	ID	on	the	Referrals	tab.
10.	 Verify	the	information	on	the	A/R Information	tab	and	update	if	necessary.
11.	 Click	OK	when	you	have	finished	entering	the	client’s	information.

Add new patients 

1.	 To	add	a	new	patient,	do	one	of	the	following:
•	 If	adding	the	new	patient	while	adding	a	new	client,	right-click	and	click	New	or	double-click	in	the	Patients	
area	at	the	bottom	of	the	Information	tab	on	the	Client	Information	window.

•	 If	adding	a	new	patient	to	an	existing	client,	on	the	Patient	Clipboard	window,	right-click	in	the	Patient List	
area	and	click	New.

2.	 In	the	Patient ID	box,	enter	a	patient	ID	or	let	Cornerstone	automatically	select	a	patient	ID.	If you are adding 
an existing patient from your previous software, make sure the ID matches.

3.	 Complete	all	the	applicable	fields	on	the	Information	tab.
4.	 On	the	Letter Reminders	tab	or	Call Backs	tab,	complete	all	reminder	information	and	due	dates	if	

vaccinations	or	relevant	services	were	provided	at	another	clinic,	and	will	be	administered	from	your	practice	in	
the	future.
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5.	 On	the	Prompts/Notes	tab,	add	information	regarding	the	patient.
6.	 The	Referrals tab	is	for	referral	clinics	that	want	to	track	from	which	veterinary	clinic	this	patient	was	referred.	

Additional	setup	may	be	required;	see	“Chapter	23:	Setting	Up	Referral	Relationship	Management"	in	the	
Cornerstone Administrator's Manual.

Change patient information  

1.	 With	a	client's	account	displayed	on	the	Patient	Clipboard	window,	right-click	the	patient’s	name	in	the	Patient 
list area	and	select	Update.

2.	 On	the Information	tab	on	the	Patient	Information	window,	change	the	appropriate	information..
3.	 Click	the	Prompts/Notes	tab	and	select	the	appropriate	prompt.
4.	 In	the	Answer	column,	select	Yes	or	No	from	the	drop-down	list.
5.	 Click	OK	to	save	the	updates.

Enter a diagnosis

1.	 With	a	client's	account	displayed	on	the	Patient	Clipboard	window,	right-click	the	patient’s	name	in	the	Patient 
list area	and	select	Diagnosis.

2.	 In	the	Code	column,	enter	a	diagnostic	code.	Press	F2	or	double-click	to	search	for	a	code.
3.	 In	the	Date	column,	enter	the	date.	
4.	 In	the	Status	column,	select	the	appropriate	status	from	the	drop-down	list.	
5.	 In	the	Staff	column,	enter	the	provider’s	ID.	Press	F2	or	double-click	to	search	for	an	ID.
6.	 Click	OK.

 Enter problems
You can enter problems at any time and back date them.
1.	 With	a	client's	account	displayed	on	the	Patient	Clipboard	window,	right-click	the	patient’s	name	in	the	Patient 

list area	and	select	Problems.
2.	 In	the	Problem	column,	enter	a	problem	code.	Press	F2	or	double-click	to	search	for	a	code.
3.	 In	the	Severity	and	State	columns,	select	the	appropriate	information	from	the	drop-down	lists.
3.	 In	the	Staff	column,	enter	the	provider’s	ID.	Press	F2	or	double-click	to	search	for	an	ID.
4.	 Click	OK.

Enter medical notes
You can enter medical notes at any time and back date them. See the Help (press F1 on the Cornerstone Editor 
window) for detailed instructions.
1.	 With	a	client's	account	displayed	on	the	Patient	Clipboard	window,	right-click	the	patient’s	name	in	the	Patient 

list area	and	select	Medical Note.	The	Start	New	Document	window	opens.
2.	 In	the	Staff ID	box,	enter	the	staff	ID.	Press	F2	or	double-click	to	search	for	an	ID.
3.	 Locate	and	double-click	a	template	from	the	list.	The	template	opens	in	the	Cornerstone	Editor.
4.	 Enter	the	document	contents	and	add	invoice	items	or	attachments.
5.	 Format	the	document.
6.	 Select	and/or	enter	document	properties.
7.	 From	the	drop-down	box	at	the	top	right	of	the	window,	select	the	appropriate	status:	Final	or	Tentative.
8.	 Click	OK to	save	the	document.

Enter medical notes—radiology and surgery logs 

1.	 With	a	client's	account	displayed	on	the	Patient	Clipboard	window,	right-click	the	patient’s	name	in	the	Patient 
list area	and	select	Medical Note.	The	Start	New	Document	window	opens.
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2.	 In	the	Staff	ID	box,	enter	the	staff	ID.	Press	F2	or	double-click	to	search	for	an	ID.
3.	 From	the	Category drop-down	list,	select	Classic medical note.
4.	 In	the	list	of	templates,	scroll	to	locate	and	then	double-click	Cornerstone Surgery Template	or	Cornerstone 

Radiology (Imaging) Template.	The	Classic	Medical	Notes	window	opens.
5.	 Click	the	Data	Entry	button	to	open	the	Medical	Note	Information	window.	Enter	values	in	the	table	and	then	

click	OK.
6.	 To	finalize	the	medical	note,	select	the	Auto finalize after ___ days	check	box	(and	select	the	number	of	

days)	or	select	the	Final check	box.
7.	 Click	OK.
8.	 Click	Close.

Add or change rabies tag information

1.	 With	the	patient	selected	on	the	Patient	Clipboard	window,	select	the	Tags/Microchip ID	tab	in	the	Patient 
information	area.

2.	 Right-click	in	the	tag	list	area	and	select Reissue	to	add	a	new	tag	or	select	Add Existing to	add	a	tag	that		
was	issued	by	another	veterinarian.

3.	 Enter	the	applicable	information.
4.	 Select	the	Print Certificate	check	box, if	applicable.
5.	 Click OK.

Enter vital signs

1.	 Click	the	Vital Signs/Weight		 	button	that	
displays	on	many	windows	throughout		
Cornerstone.

2.	 Click	the	add more vital signs	link.
3.	 Double-click	in	the	Create New Vital Signs 

set column.
4.	 In	the	Date/Time/Staff ID	fields,	verify	or	change	the	

date/time	and	provide	the	ID	of	
staff	member	entering	vital	signs	for	this	
patient.

5.	 In	the	Create new...	column	entry	fields,	double-click	
in	each	field	to	record	vital	signs	as	applicable	for	this	patient.

6.	 When	you	are	finished,	click	Save to	save	the	vital	signs	set	to	patient	history.

Change client records 

1.	 With	a	client's	account	displayed	on	the	Patient	Clipboard	window,	right-click	in	the	Client information area	
and	select	Update.

2.	 Click	the	appropriate	tabs	to	update	and	change	the	information.
3.	 Click OK	to	save	the	changes.

Schedule appointments
1.	 With	the	patient	selected	on	the	Patient	Clipboard	window,	right-click	and	select	Appointment Scheduler.	The	

Schedule	for	Today	window	opens.
2.	 If	your	practice	has	staff	members	with	different	hours,	select	the	schedule	for	a	specific	staff	member.	
3.	 Double-click	in	an	available	time	slot	in	the	schedule	or	select	a	time	slot	and	click	Schedule.	The	New	

Appointment	window	appears.	When	prompted	to	schedule	an	appointment	for	the	selected	patient,	click	Yes.
4.	 Fill	out	the	applicable	information	for	the	appointment.
5.	 Click	OK	to	save	the	appointment.
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Go Live Task Checklist 

During	the	Go	Live	phase	of	installation,	your	practice	will	be	live	on	your	new	Cornerstone	system.	Go	Live	usually	occurs	after	completing	default	settings	
and	rekeying	your	data.

Review	the	checklist	list	below	immediately	after	you	finish	rekeying	and	are	approaching	Go	Live	time.	The	following	tasks	should	be	completed	or	monitored	
during	the	first	day	of	Go	Live.	

Task Checklist Description Resources Practice Benefit

Have someone available who has 
a good grasp of the software and 
who can coach, encourage, and 
support the staff.

Be	prepared	to	coach	the	staff	through	
various	procedural	steps.	Support	them	
and	provide	praise!	Consider	a	software	
“expert”	for	the	front	staff	and	back	staff,	
if	applicable.

Your	encouragement	and	patience! Operational	efficiency,	customer	service,	
and	employee	motivation.

Complete setting up the Staff 
List.

Set	up	the	information	for	each	staff	
member,	such	as	name,	address,	phone,	
etc.

Refer	to	the	Default and Security Settings 
Guide.	
Go	to	Lists > Staff	to	set	up	staff	
members.

Allows	all	staff	members	to	use	
Cornerstone.

The	staff	IDs	will	be	used	for	logging	in,	
invoicing,	prescriptions,	medical	history	
tracking,	and	daily	planner	usage	and	
record	tracking.

Complete Security Setup. Set	up	staff	passwords	and	different	
levels	of	access	to	information	based	on	
a	staff	member’s	password.	

Refer	to	the	Default and Security Settings 
Guide.

Based	on	the	security	assigned	to	the	
login	ID,	access	may	be	granted	or	
restricted	for	various	components	of	
Cornerstone,	specific	dialog	boxes,	
or	specific	reports.	You	may	want	to	
consider	setting	up	multiple	levels	of	
security.

Set printer assignments for all 
workstations to print invoices, 
prescriptions, and reports.

Each	workstation	needs	to	be	configured	
properly	so	invoices,	reports,	and	
documents	printed	from	that	workstation	
go	to	the	appropriate	printer.

See	Printer Assignments on	page	7	in	
this	guide.
Go	to	File > Printer Assignments.

Ensuring	print	jobs	print	to	the	correct	
printer	improves	the	speed	of	providing	
client	service	and	patient	care.

Each	workstation	needs	to	be	configured	
properly	so	labels	printed	from	that	
workstation	go	to	the	appropriate	printer.

See	Printer Assignments on	page	7	in	
this	guide.
Go	to	File > Printer Assignments.

Ensuring	print	jobs	print	to	the	correct	
printer	improves	the	speed	of	providing	
client	service	and	patient	care.

Review	the	default	End	of	Day	reports	
your	practice	set	up	to	print.	These	
reports	will	print	when	you	process	your	
End	of	Day,	which	could	be	once	or	
multiple	times	in	any	given	day.

Go	to	Controls > Defaults > Practice 
and Workstation > End of Period.

Operational	efficiency.
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Task Checklist Description Resources Practice Benefit

Electronic appointment schedule 
- Review future appointments 
entered in Appointment 
Scheduler and ensure all are 
entered.

Check	the	appointments	in	the	paper	
appointment	book	and	compare	that	with	
those	on	the	Cornerstone	Appointment	
Scheduler	window	OR	check	the	
appointments	on	the	printed	appointment	
report	from	your	old	system	and	compare	
that	to	appointments	entered	into	
Cornerstone’s	Appointment	Scheduler.	

Focus	on	a	manageable	period	of	time	
such	as	the	next	week,	then	the	next	
month,	etc.

Refer	to	Setting	Up	the	Appointment	
Scheduler	on	p.	6	and	Using	the	
Appointment	Scheduler	on	p.	9	in	this	
guide.

Client	service	and	patient	care.

Review documents and labels 
needed immediately to run the 
practice.

Set	up	the	documents	or	labels	you’ll	
need	immediately	for	check-in	or	
invoicing	(release	forms,	referral	forms,	
cage	cards,	labels,	etc.)	Set	up	the	ones	
you	need	right	now,	the	rest	can	wait.	

Refer	to	Setting	Up	Medical	Notes	and	
Correspondence	on	p.	7	in	this	guide.

Operational	efficiency	and	patient	care.

Ensure all staff entering 
payments are set up with an 
applicable Cashier ID, if tracking 
payments received by staff.

If	your	practice	is	tracking	payments	
received	(by	staff	or	drawer),	ensure	that	
all	staff	are	entered	and	are	aware	of	
their	unique	cashier	password.

Activating	the	cashier	ID	feature:	
1.	Activate	the	Cashier	ID	feature:	
				Controls > Defaults > Practice and  
    Workstation > Account.	Select	the	
				Use Cashier ID check	box.	
2.	Close	Cornerstone	and	open	it	again.
3.	Lists > Cashier ID > 
    New/Update.	Enter	ID.

Drawer	balancing	and/or	tracking	for	
transaction	questions.

Verify clients are being checked 
in and out correctly by viewing 
the Census List.

The	Census	List	displays	pets	currently	
checked	into	the	hospital.

F3	or	Lists > Census. Operational	efficiency.

View the Daily Planner hourly 
to verify charges are being 
transferred from the Patient Visit 
List to invoices.

Verify	that	the	process	of	transferring	
items	from	the	Patient	Visit	List	to	the	
invoice	is	being	completed.	

Items	may	still	be	on	estimates,	
prescription	labels,	or	on	the	Patient	Visit	
List	that	should	be	on	invoices.

Daily	Planner	window Revenue
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Task Checklist Description Resources Practice Benefit

Take note of the types of 
mistakes being made during 
invoicing using the Voided 
Invoices Report. Also, check 
the Standard Fee Exception 
Summary to see if prices are 
being changed on invoices and 
both discount reports to verify 
discounts are being applied 
appropriately.

Mistakes	happen,	but	you	might	be	
able	to	spot	any	reoccurring	issues	to	
help	coach	your	staff	to	reduce	future	
mistakes.

Go	to	Reports > Client > Voided 
Invoices Report.	Set	the	Sort Order	
to	Void	and	Range to	the	current	date.	
Then,	click	Preview	or	Print.

Go	to	Reports > End of Period > End 
of Day.	Click	Current. Then	run	each	
report:	Standard	Fee	Exception	Report	
Summary,	Daily	Discount	Report-By	
Discount,	Daily	Discount	Report-By	Staff.	

Operational	efficiency

Perform a quantity control check 
on new clients

Consider	printing	the	New	Client	Report	
for	the	current	period.	Review	the	
information	for	those	clients	via	the	client	
and	patient	information	windows.	

Remember	to	coach	your	staff	on	
appropriate	capital	letter	usage.

Go	to	Reports > End of Period > End of 
Day.	Click	Current,	and	then	select	New	
Client	Report-By	Client	ID	or	New	Client	
Report-By	Client	Last	Name	(depending	
on	how	you	would	like	the	data	in	the	
report	to	be	sorted).

Client	and	patient	care
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Invoice Item Setup List 
Information Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

ID

The	unique	ID	assigned	to	each	invoice	
item	ID.	This	ID	can	automatically	be	
assigned	by	the	computer	or	you	can	
create	your	own	using	alpha	and/or	
numeric	characters.

R R R R R

Type	of	Invoice	
Item	
(Inventory, Service, 
Group, Pick, 
Dispensing)

Categorizes	the	invoice	items	and	
controls	which	fields	are	now	available	for	
setup	and	modification. Selection	Required	(Choose	One)

Hospital	
description

How	do	you	want	to	look	up	this	item	and	
have	it	listed	in	medical	history? R R R R R

Client	
description

How	do	you	want	this	item	to	appear	on	
an	invoice,	estimate,	or	reminder	card?	
If	you	leave	the	client	description	blank,	
it	will	automatically	use	the	hospital	
description.

O O O O O

Classification	-	
Primary

Used	for	invoice	item	searching,	reporting	
selection,	travel	sheet	management,	
creating	pick	lists,	mass	markup	selection	
for	mass	price/tax/discount/dispensing	
changes,	General	Ledger	manual	extract,	
and	staff	commission	exceptions.

R R R R R

Classification	-	
Subclass

Used	for	invoice	item	searching,	reporting	
selection,	travel	sheet	management,	
creating	pick	lists,	mass	markup	selection	
for	mass	price/tax/discount/dispensing	
changes,	and	staff	commission	
exceptions.

O O O O O

Default	
revenue	center

Used	during	invoicing.	If	the	invoice	item	
doesn’t	have	a	default	revenue	center	
assigned,	then	Cornerstone*	looks	at
the	invoice	item’s	classification	revenue	
center.	If	nothing	is	assigned	there,	then	
Cornerstone	looks	at	the	staff	on	the	
invoicing	line.	Revenue	centers	for	invoice	
lines	can	be	changed	at	the	time	of	
invoicing.	Revenue	centers	are	used
in	reports	such	as	the	monthly	report	
Serv.	and	Inv.	Sales	by	Revenue	Center	–	
Class	Desc.

O O O O O

Sell	barcode
If	you	have	a	bar	code	scanner,	list	the	
barcode	for	the	buy	and/or	sell	unit	of	
measure.	

O O O O NA

Status		
(Active	or	
Inactive)

Mark	an	invoice	item	as	inactive	only	
when	you	have	discontinued	use	of	the	
item	and	do	not	want	it	to	display	on	
lookup	lists	related	to	invoicing.

R R R R R

Miscellaneous	
item

Select	this	check	box	only	if	you	
want	your	staff	to	have	the	ability	to	
overwrite	the	description	while	invoicing.	
Recommendation:	Do	not	use	for	
inventory	items.

O O O O O



Information Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Controlled	
substance

Select	this	check	box	to	track	the	item	on	
the	Controlled	Substance	Report. O NA NA NA NA X

Hazardous/
MSDS

Select	the	Hazardous	check	box	if	the	
product	is	considered	hazardous.	If	you	
select	Hazardous,	select	MSDS	if	your	
practice	has	the	product’s	Materials	
Safety	Data	Sheet	required	by	law.

O NA NA NA NA X

Unit	of	
measure

Select	the	selling	unit	of	measure	from	
the	drop-down	list.	If	you	don’t	want	
to	use	a	unit	of	measure,	then	select	
[None].	If	this	item	is	marked	to	maintain	
QOH,	the	UOM	should	be	the	lowest	unit	
administered	or	dispensed.	If	the	UOM	is	
not	on	the	list	of	options,	close	out	of	the	
window,	and	select	Controls > Units of 
Measure	to	set	it	up.

R NA NA NA NA X

Minimum	price

Type	the	minimum	price	to	charge	the	
client.	This	price	displays	on	the	invoice	
until	the	invoice	item’s	(quantity	x	price)	
+	dispensing	fee	equals	the	base	price	
located	in	the	Amount	field	to	the	right.	
Then	the	item	is	priced	as	usual.

O O NA NA NA

Dispensing	fee Included	in	the	price	of	the	item	when	the	
item	is	invoiced. O NA NA NA O

Override	the	
inventory	price	
and	apply	only	
the	dispensing	
item	fee

When	the	type	of	invoice	item	is	
Dispensing,	select	this	check	box	to	
override	the	inventory	price	and	use	only	
the	dispensing	item	fee.

NA NA NA NA O

Omit	
dispensing	fee	
for	multiple	
patients

Select	this	check	box	to	charge	the	
dispensing	fee	only	once	per	invoice. O NA NA NA NA X

Dispensing

Click	this	button	to	open	the	Dispensing	
Information	window,	where	you	can	
select	an	invoice	item	that	is	linked	to	
another	inventory	invoice	item	record.	
Allows	you	to	add	an	additional	amount	or	
percentage	of	price	to	an	item.	Item	price	
and	dispensing	item	price	are	combined	
on	invoice	to	display	only	one	item	price.	
Note:		When	a	dispensing	fee	is	selected,	
the	button	displays	Dispensing…

Select	the	Allow All	check	box	to	allow	
staff	to	click	Show All,	which	allows	them	
to	see	all	dispensing	fees	for	selection	
when	entering	charges.

O NA NA NA NA X

Estimate	
markup

Type	the	percentage	used	to	estimate	
the	high	price	range	on	estimates	for	this	
item.	

O O NA NA NA
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Information Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Auto	calculate	
price

If	the	vendor	has	increased	your	cost,	
the	item	will	be	marked	up	appropriately	
when	the	order	is	received.	(The	item	
will	never	be	marked	down.)	If	you	have	
selected	this	option,	specify	to	calculate	
by	Percentage,	or	Dollar	Amount.	If	an	
amount	does	not	calculate	evenly,	select	
the	amount	to	Round	To.

O NA NA NA NA X

Base

Type	the	price	to	charge	the	client	in	the	
Amount	field	based	on	the	quantity	listed	
in	the	Qty	field	to	the	left.

Calculation:	Cost	x	Markup	+	Cost	=	
Selling	Price

Example:	A	can	of	food	is	sold	for	$2.00	
each,	but,	if	the	client	buys	a	case	of	12	
cans,	they	are	charged	$1.85	per	can	for	
the	case.	In	the	Base	Amount	field,	the	
price	would	be	$2.00;	the	next	line	would	
list	12.00	in	the	Qty	field	with	$1.85	in	the	
Amount	field.	If	the	client	buys	13	cans,	
the	client	would	still	be	charged	$1.85	per	
can.

Can	be	
zero

Can	be	
zero

Can	be	
zero

Can	
be	
zero

Can	be	
zero

Allow	change

Always	allows	the	price	to	be	overwritten.	
Never	does	not	allow	the	price	to	
be	overwritten	unless	the	user	has	
administrator	security	privileges.

Only increases	allows	the	price	
to	be	increased,	never	decreased.	
Administrators	are	not	limited	by	this	price	
change	reason.

Only with reason	allows	the	price	to	be	
changed,	but	a	reason	must	be	entered	
for	the	change.	To	use	this	option,	
you	must	create	a	list	of	price	change	
reasons.	When	a	price	is	changed	the	
reason	will	print	on	the	Standard	Fee	
Exception	Report,	along	with	the	staff	who	
changed	the	price.	(Recommended)

Require change	always	forces	the	price	
to	be	changed.	This	safeguard	is	used	
in	cases	where	the	price	fluctuates	and	
ensures	that	the	correct	price	is	charged.	
The	item	price	must	be	set	to	zero.

R R NA NA NA
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Instructions Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Departing	
instructions

Prints	at	the	end	of	the	invoice.	Press	
F2	or	double-click	in	the	ID	field	to	select	
an	instruction.	This	instruction	displays	
when	creating	the	invoice,	but	it	can	be	
changed	on	an	individual	basis.

O O NA NA O

Prescription	
instruction

Prints	at	the	end	of	the	invoice.	Press		
F2	or	double-click	in	the	box	to	select		
the	instruction.

O O NA NA NA

Pharmacy	link	
information

Available	with	purchase	of	the	Veterinary	
Pharmacy	Reference®	module.	This	is	
used	to	link	the	invoice	item	with	the	
generic	drug	name	in	the	module.	The	
result	is	the	ability	to	calculate	dosages	
and	receive	interaction	information.

O NA NA NA NA X

Reminders Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Reminders	to	
Generate	
Letter	

Reminders	to	
Satisfy

To	set	up	an	invoice	item	to	generate	a	
reminder	postcard	or	a	call	back	and	to	
satisfy	letter	reminders,	use
the	Reminders	tab. O O NA NA NA

Tax/Disc Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Sales	tax		
to	apply

Usage	tax		
to	apply	

Discounts		
to	apply

If	this	is	a	taxable	item,	highlight	the	
appropriate	sales	and	usage	taxes.	If	
discounts	apply	to	this	invoice	item,	select	
all	discounts	that	apply.	When	this	invoice	
item	is	used,	the	sales	taxes,	usage	tax,	
and	discounts	are	automatically	applied	
if	the	client	is	set	up	to	accept	tax	or	a	
particular	discount.	Tax	and	discounts	can	
be	changed	at	the	time	of	invoicing.	
Do	not	select	Not Taxable.

O O NA NA O
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Inventory Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

NDC/DIN	Code NDC	is	the	United	States	National	
Drug	Code.	DIN	is	Canada’s	Drug	
Identification	Number	and	shows	that	
the	manufacturer	is	able	to	distribute	
the	drug.	In	both	cases,	it	is	a	national	
number	that	describes	the	drug.

O NA NA NA NA

Serial	number This	can	be	the	vendor’s	product	number. O NA NA NA NA
Maintain	QOH Select	this	check	box	to	track	this	item	in	

inventory	(maintain	quantity	on	hand). O NA NA NA NA X

Track	expiration	
dates

This	is	an	option	only	if	the	Maintain 
QOH	check	box	is	selected	for	this	item.	

Select	this	check	box	to	track	expiration	
dates	for	this	item.	Staff	will	be	required	
to	enter	an	expiration	date	when	
depleting	a	quantity	of	this	item	from	
inventory.

O NA NA NA NA X

Track	lot	
numbers

This	is	an	option	only	if	the	Maintain 
QOH	check	box	is	selected	for	this	item.	

Select	this	check	box	to	track	lot	numbers	
for	this	item.	Staff	will	be	required	to	enter	
a	lot	number	when	depleting	a	quantity	of	
this	item	from	inventory.

O NA NA NA NA X

Buy/sell	ratio This	is	an	option	only	if	the	Maintain 
QOH	check	box	is	selected	for	this	item.

If	maintaining	the	item’s	quantity	on	hand,	
select	and	enter	the	buy/sell	information.	

Examples:	1	bottle	=	200	tablets.	
Explanation:	Set	the	buy	UOM	to	equal	
the	UOM	that	you	purchase/receive.	If	
you	receive	1	bottle	of	200	tablets,	then	
the	buy/sell	ratio	should	be	1	Bottle	=	200	
Tablets	and	you’ll	be	able	to	sell	1	tablet.

O NA NA NA NA

Buy	barcode If	you	have	a	bar	code	scanner,	scan	
the	barcode	used	for	the	selling	unit	of	
measure	or	enter	the	alphanumeric	code.	
(It	is	typically	found	on	the	label	of	the	
box/bottle/container.)	The	buy/sell	ratio	
must	be	greater	than	1:1	for	this	box	to	
be	available.

O NA NA NA NA

Item	Vendor Click	this	button	to	open	the	Item	Vendor	
Information	window,	where	you	can	view	
and	edit	vendor	information	for	this	item.

O NA NA NA NA

Stock	at	
locations	list

Select	the	locations	where	this	inventory	
item	is	stored.
Locations	are	set	up	at	Inventory > 
Locations.

O NA NA NA NA

Reorder	
Information	by	
Location

Set	dates,	reorder	points,	reorder	
quantities,	and	overstock	points	for	each	
location	where	the	item	is	stored.

Select	Location When	the	inventory	module	feature	is	
configured	to	multi-location	inventory,	this	
field	becomes	available.

O NA NA NA NA
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Inventory Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

From	and	To If	the	item	is	seasonal,	change	the	
months	for	which	the	information	is	valid	
and	enter	the	Reorder	Pt,	Reorder	Qty,	
and	Overstock	Qty	for	each	period.	If	the	
item	is	not	seasonal,	type	the	information	
for	the	January	to	December	period.

O NA NA NA NA

Reorder	Pt. The	number	of	doses	at	which	the	
reorder	should	be	placed. O NA NA NA NA

Reorder	Qty. How	many	units	should	be	reordered. O NA NA NA NA
Overstock	Qty. The	number	of	units	in	inventory	

after	which	additional	units	would	
be	considered	overstock.	This	is	the	
maximum	number	of	units	you	want	to	
have	in	the	practice.

O NA NA NA NA

Vaccine Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Issue	
vaccination	
tag

Vaccine	tags	to	encompass	all	types	
of	vaccinations,	including	rabies	and	
large	animal	vaccines	(e.g.,	Brucellosis	
vaccinations).

O NA NA NA NA X

Rabies	tag Select	this	check	box	if	this	vaccine	is	for	
a	rabies	tag. O NA NA NA NA X

Producer/Mfg: The	producer/manufacturer	for	the	
vaccine.	This	ties	the	information	directly	
to	the	product	being	administered.

O NA NA NA NA X

Brand The	brand	of	vaccine.	This	ties	the	
information	directly	to	the	product	being	
administered.

O NA NA NA NA X

Type Select	the	type	of	vaccine:	Killed,	MLV	
(modified	live	virus),	Recombinant,	Other,	
or	<None>.

O NA NA NA NA X

Administration	
by	species

You	can	now	set	up	the	most	frequently	
used	Manner	of	Administration/Years	
combinations	for	each	species.

O NA NA NA NA X

Manage	List Click	this	button	to	open	the	Manner	of	
Administration/Years	window,	where	
you	can	add,	delete,	and	manage	the	
combinations	of	administration/years.

O NA NA NA NA X

Available	lot	
numbers	and	
expiration	dates

You	can	create	a	list	of	available	lot	
numbers/expiration	dates	that	will	be	
available	to	select	when	creating	the	
vaccine	tag.

O NA NA NA NA X
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Link Items Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Link	items The	Link Items	tab	helps	you	to	maintain	
quantity	on	hand	for	inventory	items	
that	are	associated	with	a	service	item	
or	another	inventory	item.	Linked	items	
are	removed	from	inventory	totals	as	the	
result	of	a	sale.

O O NA NA NA X

Special Actions Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Special	actions Use	the	drop-down	lists	to	add	any	
special	actions	associated	with	this	
invoice	item	and	indicate	when	to	apply	
them.	Selections	include:

•	 Feeding	Guide	Software
•	 Image	Request
•	 Lab	Request
•	 Mark	as	Deceased
•	 Prescription	Label
•	 Print	Document
•	 Sex	Modification
•	 Update	Microchip	ID
•	 Update	Vital	Signs
•	 Vaccine	Tag

O O NA NA NA

Travel Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Travel	sheets	
to	appear	on

Highlight	travel	sheets	on	which	you	want	
this	invoice	item	to	appear.	This	can	also	
be	accomplished	through	Lists	>
Travel Sheets.

O O O O NA

Whiteboard Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

Type The	name	of	the	Patient	Order	item	field	
as	it	appears	in	its	associated	column	on	
the	Patient	Orders	window.

O O NA NA NA

Value The	default	value	to	use	for	this	field	on	
the	Patient	Orders	window. O O NA NA NA

Rules Icons	in	this	column	indicate	the	current	
“change	rules”	set	for	this	field.	See	the	
corresponding	field	explanations	below	for	
information	on	these	icons.

O O NA NA NA
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Whiteboard Tab R=Required	Field;			O=Optional	Field;			NA=Not	Applicable

Field Description/Explanation Inventory Service Group Pick Dispensing
Inventory	
Exclusive	
Field

[Field	type]	
default

Depending	on	the	field	type	selected	
on	the	left,	a	drop-down	list,	text	box	or	
check	box	may	appear,	allowing	you	to	
specify	the	default	value	for	this	Patient	
Orders	item	field.	If	you	want	to	require	
staff	to	enter	or	select	the	value	at	the	
time	the	order	item	is	added	on	the	
Patient	Orders	window,	set	the	default	
value	to	<Blank>.

O O NA NA NA

Quantity The	default	value	used	on	the	Patient	
Orders	window. O O NA NA NA

When	this	
default	is	
changed	on	the	
Patient	Orders	
window

Allows	you	to	select	one	of	the	following	
“change	rules”	to	be	followed	when	this	
field's	value	is	changed	on	the	Patient	
Orders	window.

O O NA NA NA

•	Also	change	
the	above	
default

When	this	field's	value	is	changed	on	the	
Patient	Orders	window,	Cornerstone	will	
make	the	change	value	the	new	default	
value	for	this	file	(and	automatically	
update	the	default	value	listed	on	the	
Whiteboard setup	tab).	For	all	fields	
except	Quantity,	this	is	the	option	that	
will	be	selected	by	default	upon	installing	
Cornerstone	and	when	setting	up	a	new	
invoice	item.

O O NA NA NA

•	Do	not	
change	
the	above	
default

When	this	field's	value	is	changed	on	the	
Patient	Orders	window,	Cornerstone	will	
not	make	the	changed	value	(it	will	leave	
the	default	value	as	it	is	listed	on	the	
Whiteboard setup	tab).	For	the	Quantity	
field,	this	is	the	option	that	will	be	selected	
by	default	upon	installing	Cornerstone	8.2	
and	when	setting	up	a	new	invoice	item.

O O NA NA NA

Editing	
permissions

Allows	you	to	select	one	of	the	following	
rules	to	determine	which	staff	are	allowed	
to	edit/overwrite	the	default	value	for	this	
field	on	the	Patient	Orders	window.

O O NA NA NA

•	All	staff	may	
edit

All	staff	with	Patient	Orders	permissions	
are	allowed	to	edit/overwrite	the	default	
value	for	this	field	on	the	Patient	Orders	
window,	regardless	of	whether	they	
have	been	granted	Whiteboard	Orders	
Override	security	permissions.	This	is	
the	option	that	will	be	selected	by	default	
upon	installing	Cornerstone	and	when	
setting	up	a	new	invoice	item.

O O NA NA NA

•	Only	staff	
with	security	
permissions	
may	edit

Only	those	staff	members	with	
Whiteboard	Orders	Override	security	
permissions	in	Cornerstone	are	allowed	to	
edit/override	the	default	value	for	this	field	
on	the	Patient	Orders	window.

O O NA NA NA

�� If	a	field's	default	value	is	set	to	<Blank>	on	the	Whiteboard setup	tab	and	therefore	appears	blank	on	the		
Patient	Orders	window,	all	staff	with	Patient	Orders	permissions	are	allowed	to	enter	or	select	a	value	for	this	field,	
regardless	of	whether	they	have	been	granted	Whiteboard	Orders	Override	permissions	in	Cornerstone.
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Medical Notes and Correspondence Bookmark List 

File	Descriptions	and	Bookmarks	are	listed	below.

Bar	Codes

	 BC	Client	First	Name
	 BC	Client	Full	Name
	 BC	Client	ID

BC	Client	Last	Name
BC	Patient	ID	
BC	Patient	Name
BC	Staff	First	Name	

BC	Staff	Full	Name
BC	Staff	ID
BC	Staff	Last	Name

Boarding

Arrival	Date
	 Arrival	Time
	 Boarding	Status

Cage	Number	
Cage	Type
Departure	Date

Departure	Time
Patient	Information

Choice

												our/your us/you we/you

Client

Address	1
Address	2
All	Phones
City
Classification
Client	Signature
Credit	Code
Current	A/R
Date	Client	Entered
Email	Address
Finance	Charges	A/R
First	Name
Full	Name
ID
Last	Month	A/R

Last	Name
Last	Payment	Amount
Last	Payment	Date
LY	Sales	–	Inventory
LY	Sales	–	Services
LY	Visits
Middle	Initial
Ninety	Days	A/R
Note
Outstanding	Balance
Overdue	Balance
Phone	Description
Phone	Extension
Phone	Number
Postal	Code

Referred	Address	1
Referred	Address	2
Referred	By	Name
Referred	City
Referred	Postal	Code
Referred	State
Secondary	Name
Sixty	Days	A/R
State
Status
Thirty	Days	A/R
Title
YTD	Sales	–	Inventory
YTD	Sales	–	Services
YTD	Visits

Imaging

Image Patient	Picture

Invoice	Items

	 List

Lab

	 Lab	Results
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Medical	History

Abnormal	Exam	Observ.	Only All	Exam	Observations
Departing	Instructions
	

Patient	Diagnosis

Medical	Notes

Medical	notes	found	in	Samples	and	Classic	Medical	Notes	categories	Header	and	Footer	
																																																																																																																	Header	and	Footer	w/fonts

Merge

Invoice	Item	BC Invoice	Item	Desc	(description) Invoice	Item	ID

Miscellaneous

Current	Date Current	Time

Patient

Age
Birth	Date
Breed
Check	In	Date	(Last)
Check	In	Time	(Last)	
Check	Out	Date	(Last)
Check	Out	Time	(Last)
Color
Current	Weight
Current	Weight	Unit
Current	Weight	Unit	Date
Date	Current		Weight

Date	Patient	Entered
Deceased	Date
Manner	Of	Injection
Markings
Microchip	ID
Name
Number	Of	Years
Patient	Classification
Patient	ID
Patient	Note
Patient	Status
Rabies	Expiration	Date

Rabies	Tag	Date
Rabies	Tag	Number
Registration	Number
Sex
Species
Vaccine	Amount
Vaccine	Expiration
Vaccine	Lot	Number
Vaccine	Name
Vaccine	Producer
Vaccine	Type

Practice

All	Phones
Clinic	Address	1

Clinic	Address	2
Clinic	City
Clinic	Name
Clinic	Name	2

Clinic	Phone
Clinic	Postal	Code
Clinic	State

Prescription	Inst	(instructions)

List

Question

	 Displays	a	window	for	a	question	to	be	entered.
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Referral	Doctor

All	Phones
Ref.	Doctor	Address	1
Ref.	Doctor	Address	2
Ref.	Doctor	City
Ref.	Doctor	Email
Ref.	Doctor	Fax

Ref.	Doctor	First	Name
Ref.	Doctor	Full	Name
Ref.	Doctor	Last	Name
Ref.	Doctor	License
Ref.	Doctor	Note
Ref.	Doctor	Phone	Desc		
(description)

Ref.	Doctor	Phone	Extension
Ref.	Doctor	Phone	Number
Ref.	Doctor	Postal	Code
Ref.	Doctor	State
Ref.	Doctor	Title

Referral	Hospital

All	Phones
Ref.	Hospital	Address	1
Ref.	Hospital	Address	2
Ref.	Hospital	City

Ref.	Hospital	Email
Ref.	Hospital	Fax
Ref.	Hospital	Name
Ref.	Hospital	Note
Ref.	Hospital	Phone	Desc	
(description)	

Ref.	Hospital	Phone	Extension
Ref.	Hospital	Phone	Number
Ref.	Hospital	Postal	Code
Ref.	Hospital	State

Reminder	Info

Varies	by	Practice

Staff

All	Phones
	 Signature
	 Signature	W	/	Pwd.
	 Staff	Address	1
	 Staff	Address	2
	 Staff	City
	 Staff	Classification

Staff	Extension
Staff	First	Name
Staff	Full	Name
Staff	ID
Staff	Last	Name
Staff	License	Number
Staff	Middle	Initial

Staff	Note
Staff	Phone	Description
Staff	Phone	Number
Staff	Postal	Code
Staff	State
Staff	Status
Staff	Title

User	Def	Client

Varies	by	Practice	(depending	on	what	you	set	up	as	user-defined	prompts	
Controls	>	User Defined	prompts	>	Client tab)

User	Def	Patient

Varies	by	Practice	(depending	on	what	you	set	up	as	user	defined	prompts
Controls >	User Defined prompts >	Patient tab)

Vaccinations

	 Varies	by	clinic
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Reminder Series Diagram 
The	diagram	below	shows	an	example	of	a	continuous	loop	vaccination	series,	where	a	booster	reminder	will	be	
generated,	versus	a	no	loop	vaccination,	where	a	reminder	is	not	generated.	

Small Animal Example
Vaccination Series for Kittens (Continuous Loop)

Large Animal Example
Vaccination for pregnant Mares (No Loops)

Will continue to generate 
Booster Reminder

Does not generate a 
reminder vaccination
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End of Year Checklist 
To	help	you	prepare	to	process	your	end-of-year	processing,	we	have	prepared	the	following	checklist.

1.	 Write	off	bad	accounts.
2.	 Complete	all	invoicing	for	the	year	and	process	your	end	of	day	and	end	of	month	as	you	usually	do.	Don’t	

forget	your	backups!
3.	 Be	sure	all	open	invoices	are	closed	(this	can	be	verified	when	end	of	month	is	run).	Exception:	If	you	want	to	

keep	hospitalizations	or	boarding	invoices	open,	you	can	do	so.	However,	because	keeping	invoices	open	can	
have	end-of-year	financial	implications,	consult	with	your	accountant	prior	to	making	this	decision.

4.	 If	you	use	the	Inventory	module,	we	suggest	that	you	print	an	Inventory	Cost	Report	and/or	an	Inventory	Cost	
Totals	Report	to	obtain	the	value	of	your	ending	inventory,	especially	if	your	practice	does	not	take	physical	
inventory	at	the	end	of	the	year
•	 The	Inventory	Cost	Report	lists	current	quantity	on	hand	and	the	current	total	cost	(value)	of	your	inventory.
•	 The	Inventory	Cost	Totals	Report	is	shorter	and	includes	the	current	total	value	of	your	inventory	but	does	not	
include	quantity	on	hand.	

•	 To	print	these	reports,	go	to		Reports> Inventory> Inventory Cost Report or Inventory Cost Totals Report.
Note: For	accurate	end-of-year	inventory	totals,	these	reports	should	be	printed	immediately	before	end-of-
year	processing	because	they	reflect	cost	data	from	the	exact	moment	they	are	printed.	Cornerstone	creates	
a	backup	copy	of	these	reports	on	the	Cornerstone	server	as	part	of	the	end-of-year	processing	(C:\Cstone\
Share\EOYInvCost	as	InvCost.pdf	or	InvCostTotal.pdf).

5.	 Make	your	end-of-year	backup.	Label	your	backup	media	(tape	or	CD)	“Year-end	backup	[year].”	Store	your	
backup	in	an	off-site	location	for	an	extended	period	of	time	(for	accounting	purposes).	We	recommend	that	you	
verify	your	backup	has	processed	without	errors.

6.	 In	Cornerstone,	go	to	Activities > End of Period > End of Year.	If	you	want	to	make	a	copy	of	your	database,	
click	Yes	when	the	"Do	you	want	to	make	a	copy	of	your	database?"	message	displays.	Click	No	if	you	do	not	
want	to	make	a	copy	of	the	database.

7.	 You	may	now	print	your	year-end	reports	and	purge	inactive	clients,	inactive	or	deceased	pets,	or	reminders.	
Although	the	end	of	year	is	a	good	time	to	purge,	purging	can	be	done	any	time	during	the	year.

You	may	also	want	to	print	holiday	mailing	labels.	Visit	the	IDEXX	Learning	Center	to	see	a	step-by-step	
demonstration.	You	can	view	the	Holiday	Mailing	Labels	snippet	video	at	idexxlearingcenter.com > On-Demand 
Learning > Snippets > Cornerstone > Holiday Mailing Labels.



Customization Task Checklist 

Tasks	addressed	in	this	section	are	unique	to	each	veterinary	practice	and	each	practice	has	different	priorities.	The	following	list	provides	a	general	
customization	guideline.

Review	the	checklist	below	for	those	tasks	that	should	be	addressed	within	a	day	or	two	of	going	live.	The	tasks	are	separated	into	two	stages:	Immediate 
Consideration Tasks,	and,	for	those	that	aren’t	so	urgent,	As Time Allows Tasks.		

Customization - Immediate Consideration Tasks

Task Checklist Description Resources Practice Benefit

Set up workstation printer 
assignments

Each	workstation	needs	to	have	printer	
assignments	set	up	properly	so	invoices,	
reports,	documents,	and	labels	printed	
from	a	workstation	are	printed	at	the	
appropriate	printer.

Refer	to	“Printer	Assignments” on	page	7	
of	this	guide.

Ensures	that	documents	print	to	the	
correct	printer	to	improve	the	speed	in	
which	you	provide	client	service	and	
patient	care.

Complete any hardware and 
software setup for Lab/Digital 
interfaces

Each	interface	requires	the	completion	
of	hardware	installation	and/or	software	
installation/configuration.

Refer	to	the	specific	lab	or	digital	
manuals.	

Contact	Cornerstone	Support	at	1-800-
695-2877.

Data	downloaded	to	patient	history	in	
Cornerstone*	helps	to	ensure	complete	
medical	history	and	reduce	manual	entry.	
Automated	results	can	increase	accuracy	
and	decrease	missed	charges.

Set a workstation for unattended 
backup

Unattended	End	of	Period	can	be	set	
up	to	automatically	make	a	copy	of	the	
database,	and/or	run	end	of	day/end	of	
month,	and/or	run	the	default	reports.

Refer	to	“Using	the	Backup	Verification	
Assistant” on	page	7	of	this	guide.

An	unattended	backup	provides	another	
source	from	which	Cornerstone	Support	
can	help	you	restore	your	data.
End	of	day/end	of	month	can	be	
processed	without	having	a	staff	member	
stay	late	at	your	practice	to	process	end	
of	period	and	print	reports.	

Customization - As Time Allows Tasks

Create groups and Smart Groups
Consider	setting	up	the	following	
Smart	Groups:

•	Sex	modification

•	Dentals

•	Surgeries

•	Annual	Vaccinations	or		
		Wellness	Exams

•	Euthanasia

Use	group	items	on	estimates,	Patient	
Visit	Lists	or	invoices.	Groups	may	
consist	of	service,	inventory,	and	pick	
items	and	may	contain	nested	groups	
(groups	within	groups).	Group	items	may	
be	set	up	to	charge	a	different	price	of	
made	“smart”	based	on	patient	species,	
sex,	age	or	weight	and	may	prompt	to	ask	
before	adding	or	ask	for	quantity	.	

Refer	to	“Setting	Up	Your	Invoice	Items”	
on	p.	6	in	this	guide.

By	using	groups	you	eliminate	the	need	
to	enter	items	individually,	reducing	time	
of	entry	and	missed	charges.
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Task Checklist Description Resources Practice Benefit

Complete Veterinary Pharmacy 
Reference® (VPR) linking.

Veterinary	Pharmacy	Reference®	(VPR)	
checks	for	drug	interactions,	calculates	
proper	dosages,	and	prints	client	and	
drug	information	sheets.

The	VPR	provides:
					•	Dosage	calculator	based	on	weight
					•	Conversion	charts	for:
										•	Temperature	conversions
										•	Weight	and	measure	conversions
										•	Common	medical	abbreviations
										•	Body	surface	area
					•	Anti-parasitic	agent	charts

Refer	to	the	Veterinary Pharmacy 
Reference User’s Guide.

Refer	to	your	sales	representative	for	
information	regarding	the	purchase	for	
the	Veterinary	Pharmacy	Reference.

Increases	performance	efficiencies	and	
level	of	patient	care.

Complete time clock setup. Time	Clock	allows	you	to	record	and	edit	
staff	hours.	Cumulative	reports	can	be	
printed	for	one	or	all	employees.

Refer	to	“Using	the	Time	Clock”	on	page	
7	of	this	guide.

Record	hours	worked	electronically.	Print	
Time	Clock	reports	and	use	for	various	
payroll	needs.

Create client correspondence 
documents or labels.

Create	documents	that	utilize	information	
in	your	database	to	produce	printed	
materials	(letters,	forms,	labels,	
certificates,	etc.)

Refer	to	“Setting	Up	Medical	Notes	and	
Correspondence”	on	page	7	of	this	guide.

Improve	client	education	and	practice	
performance.	

Update and link prescription 
instructions.

A	set	of	prescription	instructions	is	
included	in	the	database.	Update	the	
instructions	according	to	your	needs	and	
link	the	instructions	to	the	applicable	
invoice	items.

1.	 Review	the	instructions	from	
Reports >	Prescription Labels	>	
Prescription	Instruction	Report.	

2.	 Add	or	edit	prescription	instructions			
using	Lists	>	Prescription 
Instructions.

3.	 Link	the	instructions	to	the	invoice	
items	from	Lists	> Invoice Item > 
Instructions	tab.

Linking	prescription	instructions	to	
appropriate	pharmaceutical	items	
reduces	the	amount	of	time	required	to	
create	prescriptions.

Update and link departing 
instructions.

A	set	of	departing	instructions	is	included	
in	the	database.	Update	the	instructions	
according	to	your	needs	and	link	the	
instructions	to	applicable	invoice	items.

1.	 Review	reports	from	Reports 
> Invoice Item > Departing 
Instructions.

2.	 Add	or	edit	departing	instructions	
using	Lists	>	Departing    
Instructions.

3.	 Link	the	instructions	to	the	invoice		
items	from	Lists > Invoice Item > 
Instructions	tab.

Linking	departing	instructions	to	
appropriate	invoice	items	provides	the	
appropriate	information	to	the	client	and	
helps	to	ensure	that	you	are	providing	the	
best	patient	care.
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Task Checklist Description Resources Practice Benefit

Set up medical note templates.
Consider	setting	up	the	following	
templates:

•	Surgery

•	Dental

•	Fecal	

•	Radiology

Use	medical	note	templates	to	
standardize	the	entry	of	medical	note	
information.	Set	up	and	customize	a	
variety	of	medical	note	templates	for	your	
practice.	Using	medical	note	templates	
helps	to	give	the	notes	a	unified	and	
consistent	look.			

Refer	to	“Setting	Up	Medical	Notes	and	
Correspondence”	on	page	7	of	this	guide.

Medical	note	templates	guide	you	
through	the	process	of	entering	medical	
information	and	help	reduce	the	chance	
of	omitting	information.

Format	the	template	so	the	information	
will	be	entered	then	displayed	in	the	
patient’s	record	in	a	consistent	and	easy	
to	read	layout.

Set up travel sheets.
Consider	setting	up	the	following	
travel	sheets:

•	In-Clinic	Procedures

•	Surgery

•	Nutritional

•	Farm	Call	/	Large	Animal

•	Out	Patient

Using	travel	sheets	(also	known	as	
treatment,	circle	or	invoice	sheets)	
provides	an	easy	way	to	access	invoice	
items	and	add	them	to	estimates,	Patient	
Visit	Lists,	Electronic	Whiteboard	and	
invoices.	Travel	sheets	can	be	printed	
so	that	you	can	record	provided	services	
and	products	to	a	patient.			

Refer	to	“Travel	Sheets”	on	p.	10	in	this	
guide.

Travel	sheets	can	help	increase	
your	efficiency	when	adding	items	to	
estimates,	Patient Visit Lists	and	invoices.	
Printed	travel	sheets	can	increase	speed	
and	accuracy	of	recording	charges.

Complete the Hill’s® Feeding       
Guide software setup.

The	Hill’s	Feeding	Guide	Software	is	a	
tool	designed	to	help	you	recommend	the	
appropriate	Hill’s	diet	for	a	patient.	

The	Feeding	Guide	Software	shows	your	
clients	the	financial	benefit	of	feeding	
their	pets	Hill’s	products	and	the	proper	
feeding	instructions	for	a	healthier	pet.	

1.	 Set	up	Hill’s	pet	foods	products	as	
inventory	items.	

2.	 Link	the	Feeding	Guide	Software	
special	action	to	the	items.

3.	 Set	up	the	Hills	Feeding	Guide	
Software	from	Activities > Feeding 
Guide > Feeding Guide Setup.	

Hill’s	Feeding	Guide	software	can	help	
improve	client	education	and	patient	care.

Set up reminder templates and 
messages.

Reminder	templates	are	available	for	use	
in	both	Cornerstone	and	Microsoft®	Word.	
Set	up	the	templates	for	reminders	and	
reminder	messages.	

Refer	to	“Setting	Up	a	Reminder	System”	
on	p.	6	of	this	guide.

Customize	reminders	to	maximize	
reminder	compliance	and	help	produce	a	
revenue	stream.	
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